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GENERAL INFORMATION
With eDeposit there are six tabs that the user can access: Change Password, Administration, Registration, 
Deposits, History and Reports.
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The actual tabs available will be dependent on the system role assigned to the user. The Administration 
and Registration tabs will only be present for the following roles: 

▶▶ Administrator

▶▶ Supervisor

When the user first logs into eDeposit, the Deposits tab is initially presented. The top right corner of the 
web page displays the following:

Help Selecting this link displays an online user guide for the eDeposit application.

Logout Selecting this link will exit the user from the eDeposit application.

Username This name identifies the user that is currently logged into the eDeposit 
application.

Merchant name This name identifies the merchant that is currently logged into the eDeposit 
application.
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LOGGING IN TO THE SYSTEM
Be sure that your scanner is installed connected, and powered on. For directions on installation, please 
reference your scanner installation procedures.

1.	 Launch your browser and go to your bank’s homepage: 
New Mexico Bank & Trust (https://www.nmb-t.com).

2.	 From your bank homepage, click the Login button.

RETURN TO CONTENTSRETURN TO CONTENTS

3.	 From the Login pop-up window, select eDeposit.

4.	 You will be directed to the eDeposit Login Screen. Type in your user ID and click the Login button.

•	 Your user ID will be provided to you in your welcome letter from the bank. 

NOTE: If you did not register your computer, you will need to answer the multifactor 
authentication questions at this time. Please reference pages in your scanner installation 
procedures for scanner registration instructions.
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SMARTSOURCE SCANNER USERS ONLY
Please skip to next page if not a Smartsource Scanner user.

NOTE:  If you are using a SmartSource scanner you will need 
to have the SmartSource Startup program running at this 
point.  Check to see if it is already running by looking in your 
taskbar.

If it is not running, double click the SmartSource Startup icon 
on your desktop. If you do not see the icon, please reference 
your scanner installation procedures.

If this is the first time you have run this program it will ask you 
to register the software. Fill in the fields shown below. This is a 
one-time setup procedure.

RETURN TO CONTENTS
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5.	 Type your password, click the Login button. Your password will be provided to you by the Bank.
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USING eDEPOSIT
The Deposits tab allows the user to create a deposit and view open and recent deposits.

Create Deposit This functionality allows a user to create a new deposit providing the 
Account, Deposit Control Total and any other additional, optional fields.

My Open Deposits Open deposits are deposits that have not been finalized (i.e. submitted for 
deposit). Additional items can be captured to an open deposit.

My Recent Deposits All deposits that have been finalized are listed in the My Recent Deposits 
section.

You can create new deposits, update, modify and delete any open deposits, and review the history and 
detail of submitted deposits. To use eDeposit on your internet browser, follow the steps described in this 
section.

CREATING A NEW DEPOSIT
1.	 Select the account you are depositing to from the Account drop-down list.

2.	 Calculate the deposit total and enter the amount into the Deposit Control Total field.

3.	 Click on Proceed.

4.	 The Capture Item page appears.

NOTE: If you DO NOT have electronic endorsement, be sure to have your checks properly 
endorsed before proceeding to step 5.

5.	 Load the item(s) into the scanner. 

a.	 Make sure your check(s) are aligned to the bottom right corner.
b.	 Items should face to the right.

NOTE: If using a Teller Scan, items are loaded facing out to the left.

6.	 Click Capture Items and the Capture Items pop-up box appears, then items are scanned and 
added to the deposit.  
NOTE: If you are using a SmartSource Scanner you will need to press the button on the top once 
to begin the scan.

7.	 When you are finished, click Stop Scan in the Capture Items pop-up box.

RETURN TO CONTENTSRETURN TO CONTENTS
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8.	 The Capture Items page appears again, as shown below.

9.	 Review the deposit, then click Proceed.

•	 If there are any failed items, the Correct Items webpage will appear and display those items and 
their corresponding failures and exceptions.

•	 If there are no failures, the Balance webpage appears.

NOTE: You can add more items to the current deposit by loading the items into the scanner and 
selecting Start Scan on this screen.

10.	If any exceptions exist within the deposit, then the Correct Items webpage appears. This webpage 
allows for items to be repaired for any of the following conditions:

Duplicate Item

If a duplicate item is captured, then the user is presented both the current 
and original images for verification.

Only a user assigned the role of administrator can accept a duplicate item 
into the deposit.

Amount Recognition 
Failed

The user must manually enter the amount of the item if eDeposit does not 
successfully identify the amount during capture.

Item Data Entry

The section allows for a user to enter data that will be assigned to the item in 
question.

The user must enter data for any field highlighted in yellow; however, any 
field that is not highlighted in yellow is optional.

Image Quality 
Exceptions

This section lists all of the image quality and usability errors associated with 
each item. 

Only the user assigned the role of administrator can accept an image with 
image quality and usability errors.

Reject Item  
Exception

This section provides an explanation of why an item is labeled a reject. An 
item can be considered a reject based on the following:

▶▶ The item is foreign (i.e. item drawn in Canada or Mexico)

▶▶ The scanner is unable to successfully read the MICR

▶▶ The item routing number is not a valid U.S. number

NOTE: Any user that is not assigned the Administrator or Supervisor role will not be able to accept 
any item into a deposit that is a duplicate item or a critical failure/reject.

•	 To accept an Exception Item into the deposit, all required data entry fields must contain data.  
Click Accept once all required fields are populated with data.

•	 If the choice to remove the item is made by selecting the Remove button, the item will be 
removed and the operator will be asked to acknowledge and verify that this is what is wanted.

NOTE: Any item that is removed can be recaptured.

RETURN TO CONTENTS
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11.	When the last exception in the Correct Item webpage is corrected, the Balance webpage appears, 
as shown below.

•	 If the combined item total does not match that of the deposit, then the deposit can be 
balanced and is eligible for submission. Click Proceed to continue.

•	 To edit the amount of an item, select the item in the grid and edit the amount below the image. 
Click Save to finalize any change

•	 If the calculated total matches the deposit total, and there are no failed items, then a virtual 
deposit ticket is created.

•	 Memo & Payee line—The field is a free form and allows any data to be typed in. This information 
is available within reports. Please refer to page 16 for details on accessing these custom fields 
within reports.

NOTE: This feature is not a standard feature. To add these fields, please contact the bank.

NOTE: If Save is not selected, then any changes made will not be implemented.

•	 Click Proceed.

RETURN TO CONTENTSRETURN TO CONTENTS

12.	When the deposit is in balance, the Review Capture Items webpage appears.

NOTE: Once the Finish Deposit button is pressed, the Deposit is transmitted to the Financial 
Institution and no further changes are possible.

Verify the information here and select Finish Deposit. The user will be given options to view 
reports immediately following this selection.

The following webpage appears once the deposit is submitted for processing.

The operator is given four options here for viewing reports. To return to the Initial Deposits 
webpage, click Home. 
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If you forget to pull the report immediately following the deposit, needed reports are still available for 
review within the system. Instructions for pulling the reports are available by clicking the reports tab, then 
choosing View Reports Instructions.

All deposit reports are available within the eDeposit system for 30 days. Images of deposited items are 
available through the InBusiness Online Banking system for 12 months. 

A sample of the Deposit Detail Report can be seen below.

A sample of the Deposit Detail Image Report can be seen below.

RETURN TO CONTENTS

RETURN TO CONTENTS

NOTE: The other reports are as follows:

Deposit Image Report (Front Only)

▶▶ This is the Deposit Image Report with images of the front of the checks only.

Deposit Image Report (1x3)

▶▶ This is the Deposit Image Report with front-only images in a 1x3 format (default is 2x6). Use this 
report if larger images on printed pages are needed.
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PULLING A REPORT WITH CUSTOM MEMO/PAYEE DATA FIELDS
In the Reports table, check the Include Custom Fields box. The Memo and Payee field will then be 
visible in the report.

NOTE: Memo and Payee fields are not  standard features when creating a deposit. To add these fields, 
please contact the bank.

RETURN TO CONTENTSRETURN TO CONTENTS

MODIFYING AN OPEN DEPOSIT
You can add items to, and modify individual items within an open deposit. To modify an open deposit,  
do the following:

Add Items
1.	 If you have not already done so, log in as described under Creating a New Deposit.

2.	 Under My Open Deposits, click the link for the deposit you need. The Capture Items page 
appears.

3.	 Load items into the scanner and click Start Scan. The Capture Items pop-up box appears, then 
items are scanned and added to the selected open deposit.

4.	 Continue by stopping the capture process as described in Creating a New Deposit.

Modify Items
1.	 If you have not already done so, log in as described in under Creating a New Deposit.

2.	 Under My Open Deposits, click the link for the deposit you need. The Capture Items  
page appears.

3.	 Select the item you need, then modify the item as described in the correction process under  
Using eDeposit.

Note: Items can only be modified within the Balance section of an open deposit.

Delete Items
1.	 If you have not already done so, log in as described in under Creating a New Deposit.

2.	 Under My Open Deposits, click the link for the deposit you need. The Capture Items  
page appears.

3.	 Click on the red X to the left of the item.

4.	 You will then be prompted with a box confirming that you want to delete the item. Press OK.

Delete a deposit
1.	 If you have not already done so, log in as described in under Creating a New Deposit.

2.	 Under My Open Deposits, click on the red X to the left of the deposit you want to delete.

3.	 You will then be prompted with a box confirming that you want to delete the item. Press OK.
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CHANGE PASSWORD
This tab allows for a user to reset his/her password. To reset the password, follow the instructions 
provided below.

NOTE:  Your user name and password are case sensitive.

NOTE: When changing the password it must be seven characters and have one unique character  
(for example: password@)

1.	 Enter the current user password in the Password field.

2.	 Enter the new user password in the New Password field.

3.	 Re-enter the new user password in the Confirm New Password field.

4.	 Select Change Password to complete the process.

RETURN TO CONTENTSRETURN TO CONTENTS

ADMINISTRATION
This tab allows for a user assigned the role of Administrator or Supervisor to perform the  
following functions:

▶▶ Create a new user (Only available to the Administrator Role)

▶▶ Remove an existing user (Only available to the Administrator Role)

▶▶ Edit user properties

▶▶ Set user access (Enabled or disabled)

▶▶ Reset a user password

▶▶ Reset Duplicate Item History

Below is a list of the functions available to each role that is set up.  More than one role may be assigned to 
each user.  In order to have access to all functions all roles must be selected.

Merchant Supervisor
▶▶ Register Client

▶▶ Override Capture Errors 

▶▶ Modify User Information 

▶▶ Delete Duplicate Items 

▶▶ Reset Duplicate Deposits

Merchant Depositor
▶▶ View Reports (all users) 

▶▶ View History (all users)

▶▶ Run/View Queries (all users)

Merchant Receiver
▶▶ Create, Capture, Correct, Balance and Transmit Deposits 

▶▶ View Reports (own items only)

▶▶ View History (own items only) 

▶▶ Run/View Queries (own items only)

Merchant Operator (Smart Client Only)
▶▶ Option not in use at this time.

NOTE: Having the Supervisor role does not implicitly give the user the subsequent privileges.  
For full access, give the user all available roles.
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CREATING A NEW USER
This option allows an administrator to create a new user.

1.	 To do so, click Create User. Type in the User Name, Password, Confirm Password and Email.

2.	 Assign the necessary Roles and Accounts by checking the boxes to the left of the various Roles and 
Accounts.

3.	 Click Create User to complete.

The user should appear automatically within the user list provided in the User Administration tab.

RETURN TO CONTENTSRETURN TO CONTENTS

REMOVING AN EXISTING USER
This option allows an administrator to delete a user. To do so, select the Delete icon next to the user to be 
removed. Click OK to complete.

EDITING USER PROPERTIES
This option allows an Administrator or Supervisor to configure a user’s email, assign deposit accounts 
and roles. To edit the user properties, follow the instructions provided below.

1.	 Select the Edit icon to configure a user’s email, role(s) and deposit accounts.

•	 To configure a user’s email, enter the email in the Email field.

•	 To assign/unassign role(s), select/uncheck the appropriate role(s).

•	 To assign/unassign Deposit Accounts.

NOTE: Any user assigned the role of Administrator is not displayed in this section.

2.	 Select Save to confirm all configurations.
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SETTING USER ACCESS
This option allows an Administrator or Supervisor to prevent a user from logging into the application. To 
prevent a user from logging into eDeposit, unselect the Enable/Disable box.

RESETTING PASSWORDS
This option allows an Administrator or Supervisor to reset a user’s password. To reset a user’s password, 
select the Reset link, enter the password and select Save.

REGISTRATION
This tab allows for a scanner to be registered for capture to the local client PC. The scanner is registered 
during installation and should not need to be done again. Please reference your scanner installation 
procedures.

 

DEPOSIT HISTORY
This tab allows viewing of the deposit history submitted. After clicking on the History tab, a summary of 
all deposits made will be displayed.

To view deposit history details, click on the items as shown below.
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VIEW DEPOSIT HISTORY DETAIL
Once on the Deposit History Detail screen, you can choose to generate and view Deposit Detail Reports or 
Deposit Detail Images by clicking on the links as shown below.
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SEARCH ITEMS
This option allows the user to search for specific items within the current database. To search for an 
item(s), perform the following:

1.	 Configure the search requirements by selecting the appropriate fields and entering the necessary 
text.

2.	 Select Search to initiate the search criteria.

RETURN TO CONTENTSRETURN TO CONTENTS

REPORTS
This tab allows for the configuration, presentation and output of direct merchant-related reports.

VIEW REPORTS
This option allows the user to select one of the following reports:

▶▶ Deposit Detail Report

▶▶ Deposit Image Report

▶▶ Deposit Image Report (Front Only)

▶▶ Deposit Image Report (1x3)

▶▶ Deposit Summary Report

▶▶ All Deposits Summary Report

▶▶ Export Capture Data

▶▶ Location Summary Report

 NOTE: Scanners are currently setup with one location.



Introducing your new Commercial eDeposit User Guide. Welcome to New Mexico Bank & Trust26 27

Deposit Detail Report
This report provides details of a selected deposit. To run this report, perform the following steps:

1.	 Select Deposit Detail Report. The Input Field Entry page displays.

2.	 Select a Date.

3.	 Select a Deposit Description.

4.	 Optional: Click the Include Custom Fields check box to display all relevant custom field data in 
the report.

5.	 Select a report layout of either Tab or Window.

6.	 Click the View Report button.

Deposit Image Report
This report provides summary detail of a deposit and front/back images of each item in that deposit.

To run this report, perform the following steps:

1.	 Select Deposit Image Report. The Input Field Entry page displays.

2.	 Select a Date.

3.	 Select a Deposit.

4.	 Select a report layout of either Tab or Window.

5.	 Click the View Report button.

Deposit Image Report (Front Only)
This is the Deposit Image Report with front-only images.

Deposit Image Report (1x3)
This is the Deposit Image Report with front-only images in a 1x3 format (default is 2x6). Use this report if 
larger images on printed pages are needed.

Deposit Summary Report
This report provides a summary of deposits for a specified account in the selected date range.

To run this report, perform the following steps:

1.	 Select Deposit Summary Report. The Input Field Entry page displays.

2.	 Select the deposit Account.

3.	 Enter a Location, or keep All Locations selected.

4.	 Enter a Start Date and End Date.

5.	 Optional: Click the Include Custom Fields check box to display all relevant custom field data in 
the report.

6.	 Select a report layout of either Tab or Window.

7.	 Click the View Report button.

All Deposits Summary Report
This report provides a detailed summary of all deposits captured on a given date or date range.

To run this report, perform the following steps:

1.	 Select All Deposits Detail Report. The Input Field Entry page displays.

2.	 Enter a Location, or keep All Locations selected.

3.	 Enter a Start Date and End Date. 

4.	 Optional: Click the Include Custom Fields check box to display all relevant custom field data in 
the report.

5.	 Select a report layout of either Tab or Window.

6.	 Click the View Report button.

NOTE: The Analysis Status column is primarily for items captured using Smart Deposit.

•	 Blank - Smart Deposit Virtual Items

•	 Not Applicable - eDeposit All Items

•	 Override - Smart Deposit Physical Items that have been edited.

•	 Passed - Smart Deposit Physical Items that have not been edited\viewed in the  
correction phase.

RETURN TO CONTENTSRETURN TO CONTENTS



Welcome to New Mexico Bank & Trust28 29

Location Summary Report
This report provides a detailed summary of all deposits and debits captured on a given date or date 
range by location.

NOTE: Scanners are currently setup with one location.

To run this report, perform the following:

1.	 Select Location Summary Report. The Input Field Entry page displays.

2.	 Enter a Start Date and End Date.

3.	 Select an Account.

4.	 Select a report layout of either Tab or Window.

5.	 Click the View Report button.

Export Capture Data
This feature allows deposit data to be exported in a CSV format. To run this report, perform the following:

1.	 Select Export Capture Data.

2.	 Enter a Start Date and End Date.

3.	 Select Export Report.

4.	 Choose to Save or Cancel the Export Capture Data Report.

5.	 If saving the report, configure a report name and select a location in which to save the file.

REPORT LAYOUT
This section of the documentation discusses the functionality and features available within all reports.

Flip Page This feature allows the user to display the next or previous report page.

Back to First/ 
Last Page This feature allows the user to display the First or Last report page.

Refresh This feature performs a refresh of the active report web page.

Print This feature allows the user to print the report.

Export This feature allows the user to output and save deposit data in one of three 
formats. These formats include CSV, PDF and XLS.

Zoom In/Out This feature allows the user to increase or decrease the resolution of the 
report.

Find | Next This feature allows the user to locate text within the report.

RETURN TO CONTENTS

RETURN TO CONTENTS
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eDEPOSIT TROUBLESHOOTING

SOURCE OF ISSUE PROBLEM/ERROR RECOMMENDED SOLUTION

Cannon 190 Machine consistently double feeds, jams or reads the 
wrong amounts.

Adjust sensitivity knob on the side of the machine.

Cannon 190 Scanner gives “Device not responding” error.  
Driver is installed, cords are plugged in.

Verify you have Microsoft Visual C++ 2005 & 2008 Redistributable 
Packages installed. You can download them from the following 
links: 

Microsoft Visual C++ 2005 SP1 Redistributable Package: (x86): 
http://www.microsoft.com/en-us/download/details.
aspx?id=5638

Microsoft Visual C++ 2008 SP1 Redistributable Package: (x86): 
http://www.microsoft.com/en-us/download/details.
aspx?id=5582

Epson Check advances to the middle “error” tray. Error 
message comes up and says “Double feed detected.” 
There will not be a way to proceed.

Scan the check upside down. Scan a photocopy of the check. 
Clean the sensor on the bottom of the intake tray. Send other 
checks through to see if all checks are causing this error or only 
one specific check. If all fails, contact bank to order new scanner.

Smart Source When uninstalling the CAPI/Smart Source program, it 
cannot find the install log and will not uninstall.

Contact bank.

Smart Source Smart Souce scanner does not feed check, gives  
no error.

This is usually an issue with timing. Wait to press start scan until 
the light is blinking (usually about 2-3 seconds). Then wait until 
the light is a solid green before pressing the button on the 
scanner. Also make sure to press the button and release quickly, 
don’t hold it down.

Computer If a firewall, Ports needed to have open. Ports 80, 443, and 6655 // Our IP if needed 65.125.110.132

HTLF Web Server “The server has encountered an error with  
your configuration. Please contact your system 
administrator.”

Contact bank.

HTLF Web Server “Failed to initiate new deposit.” Contact bank.

HTLF Web Server “Error: unable to get exceptions.” Contact bank.

Installation       “Error 1722: There is a problem with this Windows 
Installer package.”

Unzip the .exe file. Disable Norton temporarily.

Installation “Error 2738: Could not access VBScript run time  
for custom action” when installing driver.

Disable Anti-Virus completely and try again. If issue persists, 
contact bank.

Installation  Installation locks up without giving an error. Wait at least 15 min, sometimes the install will seem to lock up, 
but will go though if you let it sit long enough. Happens most 
often on Windows 8.

Installation “Windows cannot verify the digital signature.” Driver 
is not registerring after install.

Make sure they have the latest windows updates, uninstall and 
reinstall the driver. You may need to use the removal tool to 
completely uninstall.  

 Installation Computer asks you to enter install disk. Saying  
that it’s looking for a specific file.

Contact bank.

Installation “Error 1720: There is a problem with this Windows 
Installer package. A script required for this install to 
complete could not be run.”

Unzip the .exe file and run again; OR unzip and right click on 
setup.exe and run as admin; OR reboot computer. Check to see if 
Norton AntiVirus is running. If that doesn’t work--uninstall, 
re-install, reboot and try again. Re-create the user profile in 
windows for the user. On Windows 10; make sure when 
extracting the file, that it is also extracting the CD Install file.

Installation Failed to load client print control. Install the Microsoft Visual C++ 2010 Redistributable Package 
(x86):  https://www.microsoft.com/en-us/download/details.
aspx?id=5555. Reboot the computer and try again.

Internet Object reference error See if the site is on the trusted list and the security settings are 
correct. Also, check to be sure you are not using a scanner from 
another bank on the same PC. Make sure the correct scanner is 
registered. 

Internet No box to edit amounts Change to Compatibility View under Tools. 

Internet Multi-feed MyVision X only takes one check at a time, or 
moves much slower.

Change to Compatibility View under Tools.

Internet Internal Web Serivce Error Do not use a desktop shortcut to access the login page.

Internet Customer gets a bubble pop-up in the system tray that 
tells them that WinDriver has 30 days left in  
an evaluation period.

Install the 64-bit driver if using Windows XP 64-bit. This is not 
supported, but has worked periodically.

Internet  htlf.com not responding Try a driver reinstall. Make sure the user is a full admin on 
Windows. If they are an admin, make sure you can open the c:\
program data\advanced financial solutions folder, if not, reinstall 
by using “Run as Administrator.” Update folder permissions 
using guide in eDeposit shared folder.

Internet Server Error in/Application―Runtime Error Load the site from the main bank webpage instead of using a 
shortcut or favorite link. 

Internet Screen Sticks on Verifying Client Add htlf.com to Compatibilty View settings under Tools. Also, 
redo the standard security settings under internet options.

Internet IE Crashes after scanning the check, “Internet Explorer 
has stopped working.”

Check to make sure it registered fully. See above if the 
registration isn’t sticking. Check to make sure the user has access 
to C:\Program data\Advanced Finacial Solutions by trying to 
open that folder. If not, and if this user is an admin, contact FIS 
for help with this. We need to take ownership of this file.

Internet Scanner has to register each time they login. Check the browser security settings.

Internet Cannot change IE browser settings Contact IT to assist with settings.

eDeposit Webpage Page gets stuck on initial login page and cannot 
navigate to any page after that.

Remove any leading or trailing spaces in the account description. 
Spaces in the middle of the description are ok. For example “Bill 
Doran” is ok.  “Bill Doran ,” with an extra space after ‘Doran’ is 
not.

eDeposit Webpage Checks scan correctly, but when you click “finish 
deposit,” the deposit disappears without giving an 
error; clicking on a report gives “no report found” or 
loads a report with no images, and nothing shows in 
recent deposits.

Make sure their isn’t a space anywhere in the user name or any 
other invalid character.

eDeposit Webpage Did not receive an email for a transmitted deposit. Go in to File>Research Date then select the date and okay. Next 
go to file>retransmit. From here select the files to retransmit and 
enter okay. Enter  transmission user ID and password to make 
sure it goes correctly.

Scanner Scanner will advance checks, but produces no image 
and gives no error.

Re-install the driver, replace the power supply.  

Scanner Read failure error Clean the machine to ensure nothing is stuck in it, then reboot. 
Uninstall and reinstall.

Scanner USB Device not recognized Power down computer completely; then unplug the power from 
the outlet.  Wait a few minutes, then plug the power back ino the 
wall outlet and power the computer back on. This should reset 
everything.

Scanner Check goes through the machine, but reads 
“Processing 0 of 1”(or however many checks were ran) 
- no image appears.

Reset Windows Internet Explorer multiple times.

RETURN TO CONTENTSRETURN TO CONTENTS



Scanner/Internet “Device Library Failed to Load” Unplug the USB cable from the back of the computer, plug it 
back in to a different port. If that does not work, restart the 
computer. This can happen if the “Start Scan” button is clicked 
too quickly. Wait until the page fully loads, ~5 sec for most. Check 
that “protected mode” is not checked under the Compatibility 
View settings under Tools.

Scanner/Internet “Unexpected behavior occurred.” Merchant Check the standard Internet Options, “Download Signed 
configuration was not available while performing ActiveX…” and “Access data sources across domains.” Make sure 
authorization. User may have to re-login to get this they are set to Enable.  Do not use a desktop shortcut. Reinstall 
issue resolved. the driver.  

Scanner/Internet “Communication error with device” Unplug and replug BOTH cords from both sides. Check the 
standard Internet Options, “Download Signed ActiveX…” and 
“Access data sources across domains.” Make sure they are set to 
Enable. Do not use a USB hub. Scanner should be directly 
plugged into the computer. USB cable could also be faulty. 
Change it out to see if it makes a difference. Make sure the 
Protected Mode is not on for Trusted Sites; if it is - turn it off. 
Confirm that no firewall is setup.

Scanner/Internet “Active X control failed to load” Must be using Internet Explorer (IE). IE without add ons or IE 
64-bit will create same error. Check for IE icon that does not say 
64-bit. Reinstall the driver, or check for missing driver. Confirm 
there is no other scanner driver installed. Check the standard 
security settings, “Signed Active X, access data sources” etc.  
Under Tools >Manage Add On, check to make sure Active X is 
enabled. Reset the Browser: Tools > Internet Options > Advanced 
> Reset  Click “delete Personal Settings.”  This will delete 
everything in IE but the favorites. 

Scanner/Internet Browser refreshes after scanning checks and does not Make sure the user has full permissions. If you are the admin, 
move to next screen. contact bank.

Scanner/Internet  You receive an error saying, “64 bit browser not Re-install the driver and reboot.  
supported,” but are certain you are in IE 32 bit.

Scanner/Internet Error on the Page, not going anywhere after clicking on  Verify Internet Explorer version. Version 8 is not compatible. 
“Capture Items.” Needs to be highter.

Issue not found or resolved. Contact TM Support. 
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